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Overview 
 
This presentation is not intended to cover specifics on all available genealogy programs, only the three 
most frequently used programs that were indicated by a 2004 survey of SGGEE members.  Those 
programs, in order of responses from the 95 members who responded are: Family Tree Maker (FTM)- 47 
users; Legacy- 20 users; and Personal Ancestral File (PAF)- 11 users.  The total does not equal the 
number of respondents, as some members use more than one program, and there are also several other 
programs indicated as being used.  The three programs discussed below are also only the Windows based 
programs noted in the survey, since only 5 of the 95 members who responded to the survey indicated that 
they are using a Macintosh, and all of those were using Reunion as their genealogy program.  My review 
of these three programs is limited to the things I do regularly with a genealogy program, so my view of 
good features may not be the same as yours because of different needs we each have.  Whether you are a 
user of the most popular program, or one of the least used programs, however, this presentation should 
enlighten you on how to better use what you have, or convince you to change to a better program.  Having 
used all three of the programs discussed in this presentation, I do not believe that the most popular 
program in this survey is the best program for what I do with data or for the data that I would like to get 
from each of you, and I will indicate the reasons for that belief below.  You will, however, have to decide 
for yourself which is the best program for what you do with data.  If you know of an error in the 
information put forth as facts in this presentation, please contact me at gary@warnerengineering.com.  
Programs used in this presentation were FTM version 10, Legacy 5.0 (11 May 2004 build), and PAF 
5.2.18.0 
 
Topics covered in this presentation are: 
 
1.  Data entry 
2.  Data correction 
3.  Finding data 
4.  Exporting data 
5.  Importing data 
6.  Merging data 
7.  Source data 
8.  Other nice features to have 
 
1.  Data Entry 
 
Data input must be part of the data you have in your genealogy program, so, unless you plan on getting all 
of your data from someone else, you need to know how to enter data into your program.  Each of the three 
programs has you enter data in essentially the same manner- that is by typing in the data in specific fields.  
Each program, however, uses somewhat different means to add parents, spouses and children. 
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a.  Family Tree Maker (FTM)- enter the data in the field or side tab associated with the parents, 
spouses or children.  Add a second spouse by clicking on “People”, then “Other spouses”, 
then “Create a new spouse.” If there is already a spouse shown, you can click on the 
“Other Spouses” icon in the family group sheet view.  NOTES: (1) FTM does not make 
available a selection button to note if a person is alive or dead, so you must enter a death 
date or place for a person to become dead- there is also no apparent assumption that a 
person is dead if over a given age (usually assumed to be 120 by most other programs).  
FTM does, however, seem to take such a notation into account when importing a gedcom 
file from another program, because it adds the letter “Y” in the “died in” box.  (2)  FTM 
has only one entry field for a name.  FTM assumes that the last word in the name field is 
the surname, so when exporting FTM data to a gedcom file, all persons with only a first 
name become persons with only a surname that is, in fact, a given name.  This can be 
avoided if you enter “\\” in place of the unknown surname, but FTM does NOT prompt 
you to add such delineators.  The same addition of the “\\” is needed if you want an 
alternate name to be part of the last name, since only the last word gets shown as a 
surname in an exported gedcom file and the rest of the name becomes part of the given 
name.  On the SGGEE website, alternate names MUST be a part of the surname, or users 
will not find them as part of a search for data on the website.  (3) FTM has a limited auto-
completion feature for places- it remembers only the last 50 places.  It does, however, 
auto-complete the surname for the children of the husband entry.  FTM  does not seem to 
remember surnames for either the father or the mother.  (4) FTM does not appear to have 
a database repair utility to check for inconsistencies in the database that might be caused 
by incorrect computer shutdown, or to cleanup the database for remnants of deleted 
records, or to check the integrity of the database. 

 
b.  Legacy- enter the data in the field associated with the parents, spouses or children.  Add a 

second spouse by clicking on the spouse icon in the family view.  Add parents or children 
by clicking on the blank fields above or below the husband or wife fields.  NOTES: (1) 
Legacy has a field where you can indicate that a person is living or dead, without noting 
any death data.  Legacy also allows the user to globally change this setting for all 
individuals older than any user defined age.  This is especially useful in defining which 
persons will have their data limited when data on living persons is suppressed in a 
gedcom export.  (2) Legacy has separate fields for given names and surnames, and the 
fields remain separate names in a gedcom export.  (3) Legacy has master lists of 
surnames and places, so auto-completion is always available if a surname or place has 
ever been entered before.  (4) Legacy (Deluxe version) has a feature called “Geo 
Locator” that allows you to search for the correct spelling of a place in a world-wide 
gazetteer that is part of the program.  You can also view a map of that place if you have 
an Internet connection. (5) Legacy has a database repair utility to remove remnants of 
deleted data, and to check the integrity of the database. 

 
c.  Personal Ancestral File (PAF)-  enter the data in the field associated with the parents, spouses 

or children.  Add a second spouse by selecting the “Add” menu, and selecting “Spouse.”  
Add children, by selecting the “Add” menu and selecting “Child.”  NOTES:  (1) PAF 
does not have a feature that allows you to note that a person is deceased.  Entry of data in 
any of the death or burial date or location fields appears to make that person deceased, 
however.  (2) PAF has only a single field for entry of a name, but if you add a name 
without “//” to distinguish the surname, PAF will assume that the surname is the last 
word and then ask you to confirm that the surname is correctly noted.  (3) PAF does not 
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have any auto-completion capability, except that it will auto-complete the surname of a 
child, and also of the father of a child previously entered.  (4) PAF has a database repair 
utility to check the integrity of the database 

 
2.  Data correction 
 

a.  Family Tree Maker (FTM)- change any entry to reflect the desired change.  You can also 
detach and attach people from or to a family to correct family relationships.  NOTES: (1) 
Each data field in each record is unique in FTM, so if you have misspelled a surname or 
place name 1000 times, you must correct each entry individually, unless you use “Find 
and Replace” in the “Edit” menu, and to change all occurrences of the misspelled word in 
all fields of the entire database, and also in notes or sources.  One needs to be careful in 
making global changes, however, and it would probably be wise to review each change 
for each record instead of making a change-all correction since you will not know all the 
places that the change will occur.  This is particularly troublesome in cases where the 
spelling of a surname has changed over time.  (2) As a general comment related to all 
programs- NEVER delete a duplicate individual in your database.  Instead merge the two 
persons together so that no data is lost. 

 
b.  Legacy- change any record to reflect the desired change.  You can also detach and attach 

people from or to a family to correct family relationships.  NOTES: (1) Some of the data 
fields in Legacy are part of special master lists- they are the surnames and place names 
master lists.  Thus, to change all occurrences of a surname or place name spelling, you 
can just change the master list, and it will be changed globally, but only in the surname 
and location fields (ie., NOT in other locations).  You can also use this feature to revise 
the order of alternate names or combine different spellings of the same name.   (2) As a 
general comment related to all programs- NEVER delete a duplicate individual in your 
database.  Instead merge the two persons together so that no data is lost. (3) Legacy also 
allows a search and replace of data in 125 other individual fields, including in given 
names, and in notes and sources. 

 
c.  Personal Ancestral File (PAF)- change any record to reflect the desired change.  You can also 

detach and attach people from or to a family to correct family relationships.  NOTES: (1) 
Each data field in each record is unique in PAF, so if you have misspelled a surname or 
place name 1000 times, you must correct each entry individually, unless you use “Tools”, 
then “Search and Replace”, and to change all occurrences of the misspelled word in any 
of the following fields- places, dates, full name, notes, and multimedia file names.  One 
needs to be careful in making global changes, however, and it would probably be wise to 
review each change for each record instead of making a change-all correction since you 
will not know all the places that the change will occur.  This is particularly troublesome 
in cases where the spelling of a surname has changed over time.  (2) As a general 
comment related to all programs- NEVER delete a duplicate individual in your database.  
Instead merge the two persons together so that no data is lost. 

 
3.  Finding data 
 

a.  Family Tree Maker (FTM)- use the “Index of Individuals” to find the surname of the person 
you seek. You can also use the “Find” button in this “Index of Individuals” to locate 
individuals by the first name, but you must then step through them one name at a time.  
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Finally, you can use the “Find and Replace” feature of the “Edit” menu to find all 
occurrences of any word in the database.  NOTES: (1) As noted above, since FTM does 
not have a separate field for given names and surnames, the given names are intermixed 
in this list with the surnames.  Thus a person who has an unknown surname, but who has 
a given name of Wilhelmine, will be listed with the W part of the alphabet.  (2) Because 
given names are not a separate field, you cannot view a list of people by given names- 
say a list of all people named “Ferdinand.” (3) FTM does not allow you to select where 
the “Find and Replace” search is conducted, so you cannot limit it to just the location 
field, or any other specific field.  (4) FTM does not appear to let you find all records that 
were changed after a given date.  This feature would be useful if you would like to export 
just those names that were changed since you last shared your data with someone else.   
FTM does not use record identification numbers (RIN) 

 
b.  Legacy- use the “Name list” to find an individual, or the “Marriage list to find a specific 

couple.  The marriage list also lets you see all people in a single list who had a particular 
name and who were married.  NOTES  (1) Legacy also allows you to “Search” for any 
piece of data you seek in virtually any data field.  Thus, as examples, you could have 
Legacy give you a list of all persons who were married on a given day, or who have a 
given name that contains “Ferdinand,” or who had more than one spouse, or who are 
listed as “living” in the database, or even a combination of these examples.  (2) Legacy 
allows you to view the name list sorted by surname, by given name, or by record 
identification number (RIN).  (3)  Legacy allows you to find and tag all records that have 
been changed since a given date, AND also lets you export them AND their families. 

 
c.  Personal Ancestral File- use “Search” and then “Individuals” to find the surname or the record 

identification number (RIN) of anyone in the database.  You can also use “Search” and 
then “Advanced Focus/ Filter” to search for people by their first name- you will get a list 
that you can view.  NOTES: (1) As noted above, since PAF does not have a separate field 
for given names and surnames, the given names may be intermixed in this list with the 
surnames.  Thus a person who has an unknown surname, but who has a given name of 
Wilhelmine, will be listed with the W part of the alphabet UNLESS the naming 
convention noted in PAF (//) is followed.  (2) Because given names are not a separate 
field, you cannot view a list of people by given names- say a list of all people named 
Ferdinand, UNLESS you use the “Advanced Focus/ Filter” search. (3) PAF does allow 
you to select somewhat where the “Global Search and Replace” search is conducted, so 
you can limit it to just the “places, dates, full names, and notes” fields.  (4) PAF lets you 
find all records that were changed after a given date.  This feature is useful if you would 
like to export just those names that were changed since you last shared your data with 
someone else.  PAF, however, does not let you also export their families. 

 
4.  Exporting data 
 

a.  Family Tree Maker (FTM)-  It is fairly simple, when using FTM to export all of the family file 
to another FTM file, or to a gedcom file, but more difficult to export only a part of the 
file.  FTM uses the names gathered in a “report” to identify which names to export a part 
of the data, so creating a report that shows a single person, or the ancestors or 
descendants of a certain person, is the key to exporting those individuals.  When you 
have the report, make sure that you the “Copy/ Export Individuals” option under the file 
menu, and NOT the “Copy/ Export Family File option, or you will still export the entire 
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family file.   NOTES: (1) Make sure that when you do the export to a gedcom file, that 
you select the destination as “PAF”, and NOT “FTW”, or the person who imports the 
gedcom file will get many many import errors, unless they are also using FTM.  (2) An 
alternative, and perhaps a clearer and easier way to export the kind of data that we need at 
SGGEE, is to create a new family file that has no data in it and then use the “Append/ 
Merge Family File” to select entire lines of each person in your file.  Note that when you 
do this, you are presented with a list of individuals from which you can specify if you 
want to include the ancestors or descendants of that individual, or both.  (3) It is best to 
know the top of pedigree names before you start this process so that you can minimize 
the number of names to be selected, but also maximize the list of persons included.   

 
b.  Legacy- You can easily select individuals, or the ancestors or descendants of specific 

individuals to export to another Legacy file, or to a gedcom file, using Legacy.  You can 
also select specific ancestors and “tag” them and their descendants or ancestors for 
export.  You can also tag all persons related to any individual, including their spouses for 
export.  Finally, you can open two files in Legacy at the same time and simply drag and 
drop families from one file to the other.  NOTES: (1) As in the discussion on FTM noted 
above, you need to make sure that you note the destination of the gedcom file as PAF, 
and NOT Legacy, unless the person you are sending the file to also uses Legacy, or 
import errors will result.  (2) It is best to know the top of pedigree names before you start 
this process so that you can minimize the number of names to be selected, but also 
maximize the list of persons included. 

 
c.  Personal Ancestral File- You can easily export all the persons in your file, or you can also 

easily select individuals, or the ancestors or descendants of specific individuals to export 
to a gedcom file, but not to another PAF file.  You can also tag all persons related to any 
individual, including their spouses for export.  NOTES: (1) As in the discussion on FTM 
noted above, you need to make sure that you note the destination of the gedcom file as 
PAF (in this case PAF 5, since it has more features and capabilities than earlier versions 
of PAF).  (2) It is best to know the top of pedigree names before you start this process so 
that you can minimize the number of names to be selected, but also maximize the list of 
persons included. 

 
5.  Importing data 
 

a.  Family Tree Maker (FTM)-  There are two different types of import processes- first, importing 
gedcom data into a new empty file, and second, appending the data in one FTM file to the 
data in an existing file.  The first process is accomplished by opening FTM and then 
selecting “Open file” from the file menu.  When you do that, FTM will ask you if you 
would like to keep either the first or last part of location names that are too long.  If you 
chose to “ Append/ Merge Family File” you will be presented with a list of names in the 
new file, and you can append any person shown, or that person and his/her ancestors, or 
that person and his/her descendants. NOTES:  (1) FTM does not support the UTF-8 
character set which is one of the standard character sets for a gedcom 5.5 or PAF file, so 
during the import of a gedcom file created with UTF-8 it switches to ANSEL.  This may 
possibly cause some loss of data (FTM then tells you that UTF-8 data has “invalid 
characters for the current character set.”)  (2) If a double date or an invalid date is in the 
gedcom file, FTM will ignore the entire line of data, and the date will be lost.  (3) If a 
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surname is too long, FTM will truncate it.  I have not determined how long a name is 
allowed, but it appears to be about 60 characters or spaces. 

 
b.  Legacy- In Legacy, there are a number of ways that you can import data into an existing 

Legacy file.  First, you can import a gedcom file into Legacy.  Second, you can import 
data directly from virtually any PAF file or another Legacy file.  Finally, you can open 
two files in Legacy at the same time and simply drag and drop families from one file to 
the other.  NOTES:  (1) When you import an any gedcom file created by FTM (no matter 
whether the output was to FTM or gedcom 5.5) into Legacy, there will be an import error 
related to “Events” in FTM.  Evidently FTM does not follow recognized gedcom 
standards, so Legacy has a workaround that moves the FTM comments to Event notes in 
Legacy.  (2) As noted previously, all FTM records for individuals who have no surname 
will become individuals with only surnames that are really given names, unless the “\\” is 
used as part of the FTM name.  This is again related to the FTM use of a single field for 
given names and surnames. 

 
c.  Personal Ancestral File- you can import only a gedcom file into PAF.  NOTES: (1) PAF seems 

to import FTM files correctly (at least no errors are noted).   (2) As noted previously, all 
records for individuals who have no surname will become individuals with only surnames 
that are really given names, UNLESS the “//” is used as part of the full name in the 
gedcom file.  This is again related to the PAF use of a single field for given names and 
surnames. 

 
6.  Merging data 
 

a.  Family Tree Maker (FTM)-  FTM allows you to merge two specific individuals (please do this 
instead of deleting one of the individuals)- do this under the “People” menu, then under 
“Merge Specific Individuals.  FTM also allows you to “Merge Duplicate Individuals”, 
also found under the “People” menu.  NOTES:  (1) FTM does not allow you to select the 
criteria for the matching process that occurs before the presenting of the names for the 
merge.  (2)  FTM tries to merge Sources as well as people.  (3) As part of the merge 
process, FTM presents you with a button that says “Display merge report.”  I have looked 
at this report for some time, and still do not understand what it says.  (4) FTM seems to 
compare only a part of the full name for the merge process, thus it cannot tell that two 
people with very long surnames, but different given names are different people.  (5) FTM 
does not appear to compare birth dates as part of the merge process, but seems to rely 
only on presenting names that are the same. (6) FTM does not allow you the option to see 
which names it is merging that it thinks are the same, and does not present the criteria it 
uses to determine that they are the same. (7) FTM does not allow you the option of 
putting a merge on hold- you must complete the merge or undo all that you have done in 
one sitting. 

 
b.  Legacy- Legacy allows you to merge two specific individuals (please do this instead of 

deleting one of the individuals)- do this via the yellow “Merge” button.  Legacy also 
allows you to “Find Duplicates”- do this via the yellow “Merge” button.  NOTES:  (1) In 
either of the merge modes, you can view all data for each individual (including a 
comparison of spouses and children including birth places and birth and death dates for 
each), and also select which data to keep, or you can amend the data to be a combination 
of both records. (2) Legacy allows you to select the match criteria with many items of 
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comparison, including exact spelling or Soundex comparisons of surnames, birth date 
mismatch range, etc. (3) Legacy allows you the option of putting a merge on hold so that 
you can continue the merge at a later time.  (4) If you manually merge two names, 
Legacy looks at the surrounding family to see if there are more possible matches, and 
presents them to you for possible merging. 

 
c.  Personal Ancestral File- PAF allows you to merge two specific individuals (please do this 

instead of deleting one of the individuals)- do this via the “Tools”, then “Matrch/merge”, 
then select the left and right sides of the merge screen manually.  PAF also allows you to 
select some search criteria for a comparison of all the data in the database- do this the 
same as for the manual merge, but select “Next match” for the first machine match of 
data to appear.  NOTES: (1) PAF allows the search for possible matches to include exact 
spelling or Soundex comparison.  (2) PAF allows you to combine notes and sources, but 
does not allow you to selectively combine that data.  (3) PAF allows you to compare 
children and spouses, but you cannot view the details on the children and spouses.  (4) 
PAF does not allow you to place a merge on hold for later continuation. 

 
7.  Source data 
 

a.  Family Tree Maker (FTM)-  FTM version 10 or later shows Source information by using the 
“View” menu, and then selecting “Source”.  Earlier versions may or may not show 
Source information in this manner, if at all.  NOTES: (1) There does not seem to be any 
way to show all records that use the same master source.  Thus, you do not appear to be 
able to view all the records that have been provided to you by a given person in a single 
list. 

 
b.  Legacy-  Legacy allows you to view all sources, AND also allows you to see and tag which 

records use a given master source.  You can then view, edit and otherwise manipulate all 
of the records that are so tagged.  NOTES:  (1) Being able to view a list of names 
supplied by a particular source is an invaluable tool that lets you view all of the records 
supplied by a given source- this is especially valuable when viewing a file sent to you by 
me, since it will usually contain many separate master sources.  This saves immeasurable 
time for you, since you do not need to look at each and every record in your database to 
see if it is the same or different than your personal data. 

 
c.  Personal Ancestral File- PAF allows you to view the sources for each record, but you cannot 

view a list of all records that share a certain master source.  View a source by opening a 
record and then clicking on the yellow book icon at the right side of the “Edit Individual” 
screen. 

 
8.  Other nice features to have 
 

a.  A world-wide gazetteer built into the program- of the three programs reviewed, only Legacy 
(Deluxe version) has such a feature.  The feature also includes a US county verifier, and a 
link to Map Quest that will show you where the place is. 

b.  Full-time relationship calculator- each of the programs reviewed has a relationship calculator, 
but each offers different capabilities.  FTM shows the relationship of each person in the 
database by a process of selecting the two people to compare, and also via a “Kinship 
Report” that shows all persons in the database that are related to a specific individual.  
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Legacy allows you to customize the program settings so that you can view the 
relationship of each person in your database that is related to a specific person in your 
database.  This data can be viewed in the name list all the time, and it is also displayed all 
the time in the family view.  Legacy (Deluxe version) also has a relationship calculator 
that allows you to print the relationship between two individuals in a descendancy chart.  
PAF lets you compare the relationship of any two individuals that you select manually. 

c.  Set age for default dead- Neither FTM nor PAF have such a feature.  Legacy allows you to 
pick the age to assume that a person is dead.  You can thus determine which records will 
have data limited on in a gedcom export in which you suppress data for living 
individuals. 

d.  Set different colors for males and females and unknown gender individuals, as well as colors 
for each line of your ancestry.  Only Legacy allows you to customize the way your data is 
displayed using colors. 

e.  Show your direct line in bold.  Only Legacy allows you to easily identify your direct ancestors 
in a list of names. 

f.  Locate unlinked individuals in your database.  Only Legacy allows you to do a search for such 
individuals. 

g.  Locate individuals in your database that have more than one set of parents.  Only Legacy 
allows you to do a search for such individuals. 

h.  Locate individuals who have multiple spouses.  This is a useful feature to see if any of the 
spouses were not combined in a merge.  Only Legacy has such a feature. 

i. Tag individuals in your database so that you can export them or otherwise manipulate and view 
them.  Tagging is an easy way to mark each record that you want to manipulate in some 
way.  Thus tagging all records for individuals who are blood-related to a given person in 
your database, is an easy way to gather data for an export to a friend or to SGGEE.  FTM 
does not allow tagging.  Legacy allows tagging, and is the best of the three programs to 
then manipulate the tagged data.  PAF also allows you to tag groups of people, but is less 
capable than Legacy in this respect. 

j.  View records grouped by source ID.  Only Legacy allows you to look at a list of records that 
were supplied to you by someone else. 

k.  Be able to adjust the size of the fonts displayed on the screen, and to be able to enlarge them 
by making the viewing window larger.  Only Legacy allows you to make such 
adjustments. 

l.  Drag and drop merges of data- only Legacy allow you to drag data from one Legacy file to 
another Legacy file. 

m.  Free upgrades for bug fixes and new features- Only PAF is totally free, but upgrades to new 
versions are far apart.  The basic version of Legacy is free (unless you cannot download 
it, in which case the CD is $1.00), and the Deluxe version is $19.95 for the downloadable 
version, and all upgrades within the release number are free (Basic or Deluxe version)- 
thus, updates to the current version of Legacy 5 are free, and are downloadable every few 
weeks.  FTM (latest version is version 11) does not appear to have free updates- FTM 
costs $29.95 for a CD mailed to you (it is not downloadable). 

n.  Looking at two databases at the same time- Only Legacy can do this.  You can open what is 
called “split screen view” and look at two different parts of the same database at the same 
time, or two entirely different databases at the same time. 


